
Contents

 Virtus WalkThrough Pro 2.0
The following Help Topics are available:

Overview 

The WalkThrough Interface 

Textures 

Virtus Player Application 

Glossary 

Other Virtus Products 

For Help on Help, Press F1



Overview
What is Virtus WalkThrough Pro 2.0?    

What's New in WalkThrough Pro 2.0? 

Concepts

Volumetricity 

Dimensions

 Virtus Rules of Drawing

  
Back to Contents 



The WalkThrough Pro Interface

Back to Contents 



Textures
The Textures Window
The Textures window can be displayed or hidden with the Textures Window command under the 
Windows menu. The Textures window is used to choose textures and apply them to selected objects 
and object surfaces, and to alter the display characteristics of textures.
Within the Textures window is the Texture menu. This menu has many commands and options 
specific to working with textures. The Textures Menu is accessed by mousing down on the arrowhead
in the upper right corner of the Textures window.
Textures that have been added to the Textures window with the Add Textures command are displayed
in the Textures window as a thumbnail (a small preview picture), along with the name of the texture.
Textures in the Textures Window can be selected to be edited or applied by clicking on the name or 
thumbnail of the texture. Once selected, the texture name and its thumbnail are highlighted. The 
texture remains highlighted until another texture is selected.
If a texture is applied to any object or surface, a checkmark appears beside the name of the texture, 
indicating the texture is in use.
You can change the order of the textures listed in the Textures window by mousing down on a texture 
and dragging it up or down the list.

            Applying Textures

Textures can be applied to an entire object, to individual surfaces or as surface features. 
Textures can be applied while in any Design View, the Tumble Editor or the Surface Editor. Once a 
texture is applied, its display attributes can be altered with the Texture Options dialog under the 
Textures Menu.
When applying textures, you must pay close attention to the Placement Modifiers. Textures, like 
colors and surface features, can be applied on the inside, the outside or on both sides of an object, 
depending on the choice of Placement Modifiers.

The WalkThrough Interface 
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Virtus Player Application
Included with WalkThrough Pro 2.0 for all platforms is the Virtus Player application. Virtus
Player is an application that will open any Virtus model for viewing but not editing. It 
allows you to distribute your models freely and across platforms. Using the appropriate 
version of Player, users now have the ability to share their models with anyone with a 
386 or higher PC running Windows, or a color Macintosh running system 6.0.4 or higher. 
This application can be distributed without charge to others (provided you follow the 
license agreement contained in the Player Read Me file).

Cross Platform File Compatibility and Virtus Player

Models and Libraries created with Virtus WalkThrough Pro 2.0 are readable on Windows, 
Macintosh and Power Macintosh computer platforms. Therefore, a model created on a PC 
running Windows 3.1 using WalkThrough Pro 2.0 for Windows can be opened and edited 
on a Macintosh running WalkThrough Pro 2.0 for Macintosh, and vice versa. 

We've included the Player application in Macintosh, PowerMacintosh, and Windows 3.1 
versions with VWT Pro 2.0. The Windows version of Player is installed on your computer 
when you install VWT Pro 2.0. Some sample Player models are also included. The 
Macintosh and Power Macintosh versions of Player are included on a separate Macintosh 
disk. 

Few Windows users have software that will read a Macintosh disk. Most (not all) 
Macintosh users can read High Density DOS formatted disks. The best software for this is
called PC Exchange and is available from Apple Computer. Today all Macintoshes come 
with this software pre-installed. Users of PC Exchange can read, write, and format both 
Macintosh and DOS HD disks without doing anything special. The only requirement is 
that they have a HD Disk Drive and the PC Exchange software installed.

To send your Windows file to a Macintosh user who can read DOS disks, send them a high
density DOS formatted floppy disk with your file on it and either the Macintosh or 
PowerMacintosh version of Player (or both).

Windows users who want to copy the Macintosh Player Program disk must use a disk 
duplicating program like DiskDupe which can read and write disk images. You cannot use
the DOS or Windows diskcopy commands to copy a Macintosh formatted disk.

To move large files (over 1.4 megabytes) bewteen Macintosh and Windows computers 
you must have special utility software (contact your favorite software vendor) or use a 
direct connection. If both Macintosh and Windows computers share the same network 
the solution is simple. If a network is not available you can use modems and 
telecommunications software to move large files.

To send models to others for viewing only (thus providing no ability to edit with any 
Virtus software package) use the File Export Player command in Virtus WalkThrough Pro 
2.0. Please see the User Reference for further details.

To send models to others for viewing and editing, save the file as a Pro file and follow the
appropriate instructions above. Other users of WalkThrough Pro will be able to open and 
edit the file.
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Glossary
Active Window 
Alley 
Ambient Light 
Aspect Ratio 
Collision Detection 
Color Selector 
Coordinates Window 
Cross Hair 
Depth Controls 
Depth Window 
Design View 
Directional Lighting 
Dock 
Drawing Tools 
Embedded Textures 
Full Screen 
Group 
Handle 
Home 
Inflation 
Inflation Distance 
Inflation Modifier 
Lens Focal Length Tool 
Levels 
Library Item 
Library 
Lighting Editor Tool 
Magnify Tool 
Navigation 
Non-Reproducing Guidelines 
Observer 
Opacity Modifiers 
Opaque 
Orientation Cube 
Placement Modifiers 
Preferences 
Rendering 
Rotation Constraint Tools 
Selection Rectangle Method 
Slice List 
Slice Tool 
Smooth Shading 
Snapshot 
Surface Editor 
Surface Feature 
Texture Mapping 
3-D Object Selector 
3-D Surface Selector 
Translucent 
Transparent 
Tumble Editor Tool 
Velocity Grid 
Virtus Player 



Virtus World 
Walk View 
Window 



Other Virtus Products
Click on one of the following to display information about other Virtus products:

Virtus VR 

Virtus Alien Skin 

Virtus Galleries 
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Active Window
The window that you are currently working in. A window is active if its Title Bar is highlighted.

OK 



Alley
The area on a ruler where the Depth Control is displayed.

OK 



Ambient Light
A surrounding light source that casts its light on all surfaces of the object that you are editing and on all 
surfaces of any objects contained within the object you are editing.

OK 



Aspect Ratio
The ratio of horizontal to vertical dimensions of the Walk View.

OK 



Collision Detection
Collision Detection is the feature that prevents you from walking through walls and other 
solid objects. 

OK 



Color Selector
A spectrum of colors that can be assigned to objects or surface features.

OK 



Coordinates Window
The Coordinates Window displays object and cursor positions/measurements within the Design View.

OK 



Cross Hair
Located in the middle of the Walk View and used as a reference point for navigation.

OK 



Custom Screen
A custom Screen is a window that is displayed when a WalkThrough Pro file opens. The User 
may personalize this screen with a picture (in BMP format) and text.

OK 



Depth Controls
Appears on each ruler in the Design Views and on the ruler in the Depth Window. It determines the 
inflation distance and the position of objects.

OK 



Depth Window
Contains a ruler and Depth Control that allow you to manipulate inflation distance and position of objects.

OK 



Design View
A two-dimensional area where you draw objects. There are six possible Design Views: Front, Back, Top, 
Bottom, Left and Right.

OK 



Directional Lighting
Directional Lighting is a light source that can be directed toward one area.

OK 



Dock
A gray box that appears on the end of each ruler. The Dock displays the letter, X, Y or Z, which 
determines the axis the ruler is on. Docks also contain Non-Reproducing Guidelines, which you can drag 
to any position on the ruler.

OK 



Drawing Tools
Allow you to draw 2-D polygonal outlines of basic shapes that are interpreted as 3-D objects or 2-D 
surface features.

OK 



Embedded Textures
Embedded Textures are stored in a WalkThrough Pro model when the file is saved. The alternative is to 
link them.

OK 



Full Screen
This command opens the Walk View to cover the entire monitor screen, including the menu bar.

OK 



Group
This command groups all selected objects, treating them as a single object.

OK 



Handle
A small square block which represents the meeting of two or more planes, or in the case of an object, the 
meeting of two sides. If an object is selected, its handles are visible.

OK 



Home
A 3-D location in the Virtus world used as a base or reference for the Observer or for a Design View.

OK 



Inflation
The process of taking a 2-D polygonal outline and adding depth to create a 3-D object.

OK 



Inflation Distance
The depth or the distance that a 2-D polygonal outline is stretched to create a 3-D object.

OK 



Inflation Modifier
Determines the inflation type, or 3-D shape, of an object. Inflation is the process of interpreting a 2-D 
polygonal outline in the Design Views as a 3-D object in the Walk View.

OK 



Lens Focal Length Tool
Determines the zoom factor of the virtual camera. The Lens Focal Length Tool can be adjusted to give the
effect of viewing the Walk View through a wide angle lens or a telephoto lens.

OK 



Levels
The number of decrementing sides of an object whose inflation type is rounded or double-rounded. The 
maximum number of levels allowed is 16.

OK 



Library Item
Can be a single Virtus WalkThrough Pro object, but is usually several objects grouped together to form a 
complex shape, such as a piece of furniture. Library Items are stored in a Virtus WalkThrough Pro Library.

OK 



Library
A collection of Virtus WalkThrough Pro objects (Library Items) that can be copied and pasted into multiple 
models.

OK 



Lighting Editor Tool
The Lighting Editor Tool accesses the Lighting Editor from the Design View or the Tumble 
Editor. The Lighting Editor allows you to set the intensity and color of light sources inside a 
selected object or for the Virtus World.

OK 



Magnify Tool
The Magnify Tool increases the apparent size of the Design View drawing by factor of two, 
every time you click.

OK 



Navigation
The process of moving through the Walk View.

OK 



Non-Reproducing Guidelines
These help align objects. Non-Reproducing Guidelines are dragged out of the Dock and positioned 
anywhere on the ruler.

OK 



Observer
Represents your eyes in the virtual environment. In a Design View, the Observer is shown as a circle with 
a line that indicates the viewing direction.

OK 



Opacity Modifiers
Determine whether an entire object or a selected surface is opaque, translucent or transparent.

OK 



Opaque
Describes a selected object or surface feature that appears solid (you cannot see through it), even though
it is volumetric.

OK 



Orientation Cube
Shows the orientation of the Virtus World as seen by the Observer in the Walk View. In the Tumble Editor,
the Orientation Cube represents the selected object within the Virtus World and shows the side(s) of the 
object visible in the tumble window.

OK 



Placement Modifiers
Determine which side of a surface will be edited.

OK 



Preferences
The dialog that allows you to set preferences for the appearance of the Design and Walk Views, 
navigation, measurement units and other application and model attributes. You can customize your 
application with the Preferences dialog.

OK 



Rendering
Translation of 2-D objects in the Design View to 3-D objects in the Walk View.

OK 



Rotation Constraint Tools
These affect how the selected object or light source can be rotated.

OK 



Selection Rectangle Method
A means to select objects by dragging the Select Object Tool to form a bounding box around the objects 
that you wish to select.

OK 



Slice List
Displays the word slice and a number for each slice that you make in an object while in the Tumble Editor.
If you wish to edit a slice, click on the slice number of the slice and it will appear in the Tumble window.

OK 



Slice Tool
Adds a surface to an object by slicing off a piece of that object in the Tumble Editor.

OK 



Smooth Shading
Smooth Shading is a rendering type that softens edges, giving a smoother and more realistic
appearence to curved surfaces.

OK 



Snapshot
This command allows you to save a Design View or Walk View perspective in BMP, TIFF and Adobe 
Illustrator formats.

OK 



Subject Cube
The Subject Cube appears within the Lighting Editor window and represents objects 
contained within the object that you are editing. It also shows how light affects those 
objects.

OK 



Surface Editor
Accesses the Surface Editor from the Design Views or the Tumble Editor. The Surface Editor allows you 
to edit a selected object surface.

OK 



Surface Feature
A polygonal 2-D object that can represent items such as a door, window, or a floor or wall feature with a 
specified opacity and color on a surface. Surface Features are created and edited in the Surface Editor 
with the same tools as objects; however, Surface Features do not have depth.

OK 



Texture Mapping
Texture Mapping is the process of applying textures to surfaces.

OK 



3-D Object Selector
The 3-D Object Selector is the tool used to select an object in the walk view.

OK 



3-D Surface Selector
The 3-D Surface Selector is the tool used to select surfaces in the Walk View.

OK 



Translucent
Means that a selected object or surface feature is see-through, like glass.

OK 



Transparent
Means a selected object or surface feature is invisible except for a wire frame.

OK 



Tumble Editor Tool
Accesses the Tumble Editor from the Design Views. The Tumble Editor allows you to three-dimensionally 
rotate an object, edit a selected surface or slice off a piece of an object.

OK 



Velocity Grid
This is made up of the horizontal and vertical marks in the Walk View that determine the points at which 
the walk speed changes when you navigate through the Virtus World.

OK 



Virtus Player
The Virtus Player is an application that enables anyone to open and view (but not edit) any 
Virtus file.

OK 



Virtus World
The overall area of the Walk View.

OK 



Walk View
The window that displays a three-dimensional rendering of the objects you draw in a Design View and 
allows you to walk through and around the objects.

OK 



Window
Displays information on the computer screen in a designated area. In Virtus WalkThrough Pro, a window 
can display a tool palette, a view or an editor.

OK 



Menus
Click on a menu topic to display its description:

File Menu 
Edit Menu 
View Menu 
Design Menu 
Light Menu 
Surface Menu 
Tumble Menu 
Walk Menu 
Window Menu 
Help Menu

Back to The WalkThrough Interface    



The Tools Pad
The Tools Pad has two modes, one for the Design View and one for the Walk View.

Click on a tool to display its function (for more detailed information, refer to the manual 
supplied with Virtus WalkThrough Pro):
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The Design View
The Design View is a drawing area where you draw or view object outlines in two dimensions. There are 
six different Design Views: Top, bottom, Front, Back, Left, Right. You may draw in any Design View. More 
than one Design View can be open at any time; however, only one view can be active at any time.
The Design Views have a specific set of tools. When a Design View is active, the Design View tools are 
displayed in the Tools Pad.

Creating an Object

In the Design Views, an object is represented by a 2-D polygonal outline. To draw the polygonal outline of 
an object, select a drawing tool, point to a location in the active design view, click and drag.
The resulting polygonal outline is a 2-D cross section from which a 3-D object is derived. The polygonal 
outline may look flat, but it has depth and a position in space. WalkThrough Pro applies an inflation 
distance, or depth, to the outline and inflates the object in the same direction that you are viewing; you 
cannot see the inflation unless you change views.To change views, select a view from the Change View 
submenu under the View menu.

Back to The WalkThrough Interface 
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The Walk View
The Walk View displays a three-dimensional rendering of the objects that you draw in a Design View. In 
the Walk View, you can walk around and through objects by moving the mouse. Also in this view, you can 
select objects or object surfaces to be edited. The Walk View has a set of tools specific to the Walk View. 
When the Walk View is active, the Walk View Tools are displayed in the Tools Pad.
To move forward, click the mouse about two inches above the cross hair.
To move backward, click the mouse about two inches below the cross hair.
To rotate left/right, click the mouse about two inches to the left/right of the cross hair

ADVANCED NAVIGATION:
                                                                            Press Crtl and                                                                       
Press Shift and
To                                                place cursor                                        To                                                 
place cursor

----------------------------------------------------------------------------------------------------------------------------
-------------
Rise Up                                            Above cross hair                                            Tilt your view up             
Above cross hair                              
Sink Down                                  Below cross hair                                              Tilt your view down          
Below the cross hair
Slide Right                                Right of cross hair                                          Roll your view right            
Right of cross hair
Slide Left                                      Right of cross hair                                          Roll your view left            
Left of cross hair 

Back to The WalkThrough Interface 
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Virtus Corporation
118 MacKenan Drive 
Suite 250
Cary, NC 27511

Telephone: 919/467-9700
Fax: 919/460-4530



What is Virtus WalkThrough Pro 2.0?

Virtus WalkThrough Pro is a 3-D drawing and design package that helps you conceptualize 
and 
communicate your design ideas. Virtus WalkThrough Pro helps you conceptualize by allowing
you to create environments on your desktop computer and then walk through and explore 
those environments interactively. The software provides immediate feedback so you can 
experiment with "what if" scenarios. Virtus WalkThrough Pro helps you communicate with its 
real-time drawing capability and by offering presentation formats like Autodesk Animator 
and Video for Windows, thus providing the means for producing pre-recorded movies.

Virtus WalkThrough Pro Is Not...
Virtus WalkThrough Pro is not a CAD package. Every object in Virtus WalkThrough Pro has 
depth; therefore, it is impossible to draw with traditional line and vector CAD constructs. 
When drawing in Virtus WalkThrough Pro, basic polygons are drawn two dimensionally and 
then inflated into 3-D objects. (A polygon is a three or more sided, closed figure bounded by 
straight lines.) 

Virtus WalkThrough Pro is not intended to replace CAD, but to enhance it, as well as other 
types of applications. Virtus WalkThroughs import and export facilities make the package 
versatile when working in conjunction with other design and graphics applications. Two-
dimensional as well as three-dimensional views can be integrated into drawing, word 
processing and page layout programs, as well as most CAD packages.

Back to Overview 



Volumetricity
Space Modeling and Containment
When you draw a 2-D object in the Design View, it becomes a 3-D object in the Walk View. 
Though the object may appear solid in the Walk View, it is actually hollow. Every object has 
an interior space--it is volumetric. Volumetricity has three considerations you should be 
aware of. The first consideration of volumetricity is space modeling, that is, you are able to 
use Virtus WalkThrough Pro to model space itself. Think in terms of space (with infinitely thin
walls) defining the environment rather than the environment defining the space.

A second consequence of volumetricity is containment. Every object in Virtus WalkThrough 
Pro
knows what objects it contains and what object contains it. Containment provides you with 
some 
important benefits. For example, if you move a container, all objects contained within it also 
move.

In Virtus WalkThrough Pro, containment is an all-or-none state; an object is either fully 
contained 
within another object or it is distinct from other objects. Objects cannot overlap (but they 
can be joined at a common surface). Unfortunately, it is possible to draw overlapping 
objects, and the program does not warn you if you make this mistake; however, the result of 
overlapping objects is always the same: the three-dimensional rendered objects appear 
twisted and grotesque and sometimes just plain funky.

If you drag a small object into a larger object, a state of containment will exist when the 
mouse 
pointer reaches the interior of the large object. The program indicates containment by 
displaying 
small blocks called containment markers at the vertices of the large object. These markers 
will 
disappear when you release the mouse button. The figure at the left shows containment 
markers 
displayed as a small object is being dragged into a large object.

The third consequence of volumetricity is that each object surface has an inside and an 
outside. 
In Virtus WalkThrough Pro, you can edit the inside or outside of any surface of an object to 
create surface features. Surface features are two-dimensional shapes that can be a different 
color or a different opacity than the object surface. Surface features are used to represent 
doorways, windows, holes and other items. 

Back to Overview 



Dimensions
When speaking of three-dimensional space, the coordinate system is usually displayed or 
discribed in X,Y and Z axes (or planes). Such is the Virtus WalkThrough Pro world. Because 
the Top View is the default view when the program is started, the three dimensions are 
based on the Top View rather than the Front View, as in some other 3-D programs.

To demonstrate this, assemble your Virtus Reference Cube (if you haven't already) which is 
included with the Virtus WalkThrough Pro package. Hold it up in front of your face so the T 
(Top View) is facing you. Notice the rulers on the top edge and left edge of the Top View. At 
the bottom of the left ruler is the letter Y. This indicates the left ruler is associated with the Y 
dimension. At the right of the top ruler is the letter X. This indicates the top ruler is 
associated with the X dimension. So, when viewing or drawing objects in the Top View you 
are viewing or drawing the XY dimensions of objects.

Now, rotate the Virtus Reference Cube so the F (Front View) is facing you. Like the Top View, 
you will see a ruler on the top edge and left edge of the view. But notice at the bottom of the
left edge ruler is the letter Z indicating the ruler is associated with the Z dimension. The top 
ruler has not changed and is still associated with the X dimension. So, when viewing or 
drawing objects in the Front View you are viewing or drawing the X-Z dimensions of objects.

Now, rotate the Virtus Reference Cube so the R (Right View) is facing you. Notice the top 
ruler has changed to Y. So, when viewing or drawing objects in the Right View you are 
viewing or drawing the Y-Z dimensions of objects.

To put it another way:

X is the left/right dimension,
Y is the front/back dimension, 
Z is the top/bottom dimension. 

Back to Overview 



Virtus Rules of Drawing
When modeling, you would be wise to adhere to these rules....

1) Do not overlap objects.

2) Non-convex objects are not allowed.

3) Speed and Detail are inversely proportional.

4) Transparent and translucent objects and surfaces (as well as smooth shading) drain 
processing power.

5) You cannot draw a line. All objects drawn must have depth.

Back to Overview 



What's New in WalkThrough Pro 2.0?
For new users, or for those who have upgraded from a previous version, heres a brief look at
whats new in Virtus WalkThrough Pro 2.0:

3-D Object Selector, 3-D Surface Selector

With these two new tools, you can select an object or an objects surface in the 3-D Walk 
Window. The 3-D Object Selector helps you select an object that may not be easily 
accessible in the Design View; the new 3-D Surface Selector works exactly like the Surface 
Editor Tool, except that it works in the Walk View!

Smooth Shading

This new rendering type softens edges, giving a smoother appearence to the curved 
surfaces of objects.

Magnify Tool

A magnifying glass replaces the Zoom-In Tool. Additionally, you may access the Zoom-Out 
Tool by selecting the Magnify Tool and pressing the Crtl key. You may also constrain 
magnification by selecting the Magnify Tool and dragging a marquee around a designated 
zoom area.

Virtus Player

With this new application, which is included with WalkThrough Pro 2.0, anyone can view (but 
not edit) any file created with Virtus WalkThrough, WalkThrough Pro or Virtus VR.

Embedded Textures

You have a choice! A WalkThrough Pro model can now be saved with all its textures stored 
(embedded) in the model file. Or, as in previous versions, you can merely link the textures to
the file. Also, with the Save As... option, you can now save WalkThrough Pro files as Virtus VR
files.

Improved Printing

From within WalkThrough Pro, you can now print the 3-D Walk View of models to which 
textures have been applied.

Back to Overview 



Virtus VR
Virtus VR is a unique 3-D modeling program that features an intuitive drag-and-drop 
approach to world creation. This method of object-oriented drawing allows users to 
choose basic 3-D shapes, from galleries supplied with the program, to build more 
complex objects and structures. Retailing for just $99, this affordable program features 
one cubic mile of cyberspace, construction and navigation tools, galleries of 3-D objects
that can be added to any Virtus VR environment and six pre-built scenes that illustrate 
the program's modeling, texture mapping and real-time "walkthrough capabilities". The 
program is also supplemented by an on-going series of add-on galleries that greatly cut 
down on modeling time by providing commonly used, pre-constructed 3-D objects that 
bring life to virtual worlds. Virtus VR is available for Macintosh, Power Macintosh and 
Windows users.

To Order Virtus VR, call 1-800-847-8871 (1-800-VIRTUS1) 9:00am - 6:00pm EST

Windows System Requirements:

¥ 80386-based (or later) personal computer                                                                    
¥ at least 4MB
¥ Microsoft Windows 3.1+
¥ VGA or SuperVGA display adapter

Virtus Alien Skin    

Virtus Galleries 
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Virtus Alien Skin
Virtus Alien Skin generates stunning textures that tile seamlessly. Available for 
Windows, Alien Skin is offered as a stand-alone application or as an Adobe Photoshop 
plug-in. The drag-and-drop process ''mates'' and ''mutates'' original textures, creating an
infinite variety of new files. Vivid colors, supporting RGB and CMYK modes, are layered 
atop 3-D surfaces; adjustable lighting and shadows add realism. Compact Alien Skin 
files (under 20K) can be rendered at any size and resolution. Creative professionals 
who need unique textures for their multimedia, print or video projects will want Alien 
Skin.

To Order Virtus Alien Skin, call 1-800-847-8871 (1-800-VIRTUS1) 9:00am - 6:00pm EST

Windows System Requirements:

386 or better PC                                                                                            
8 MB RAM
Windows 3.1 or later. 

Recommended for optimum performance: 
80486/33MHz or Pentium
24-bit VGA display.

Virtus VR    

Virtus Galleries 
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Color Lifter Tool
By selecting this tool and then clicking on a surface in the Design View, that surfaces color 
becomes the currently selected color. (The Color Lifter cannot be used in the Walk View.)



The Magnify Tool
Each click of the Magnify Tool (in the Design View only) increases the apparent sixe of the 
drawing by a factor of two.There is a limit to how closely you can zoom in. When you reach the limit, 
clicking the Magnify Tool    will have no effect.
You can also zoom in by selecting Zoom In under the Design menu.

Zoom-Out Tool    
This tool is accessed by selecting the Magnify Tool    and pressing the Ctrl key. Each click of the Zoom-
Out Tool    decreases the apparent size of the drawing by a factor of 2. There is a limit to how far you can 
zoom out. When you reach the limit, clicking the Zoom-Out Tool      will have no effect.
You can also zoom out by selecting Zoom Out under the Design menu.



Select Object Tool
The Select Object Tool is used to select and edit objects. The Select Object Tool is used in the Design 
Views, Surface Editor and Tumble Editor. In the editors, the Select Object Tool functions differently than in
the Design Views.
If you are working with another tool and wish to use the Select Object Tool , press the space bar and the 
Select Object Tool will automatically be selected. Press the space bar again to go back to the previously 
selected tool.
In the Design Views and Surface Editor, the Select Object Tool is used to select, move and       
change the size or shape of objects and surface features.



Tape Measure Tool
The Tape Measure Tool    finds the distance between two points. The distance is displayed in 
the Coordinates Window. (See Coordinates Window in your WalkThrough Pro Manual.)



Scale Object Tool
The Scale Object Tool    functions in the Design Views or Surface Editor, and scales an object or surface 
feature about its center or about a specified anchor point. 
Objects may be scaled independently along any of the three coordinate axes. 
Objects may also be scaled uniformly in all dimensions (X, Y and Z) by holding down the Shift key before 
dragging.
When an object is scaled, its contents and any surface features are scaled with it unless you hold down 
the Ctrl key while you are dragging.



Skew Object Tool
The Skew Object Tool , nested under the Scale Object Tool , distorts an object from its true symmetrical 
form, making the object out of plumb. An object can be skewed on more than one axis, but only from the 
view (or opposite view) in which it was created.



Lock Object Tool
The Lock Object Tool    functions in the Design Views and in the Surface Editor, and allows you to lock 
objects or surface features so they cannot be edited. A locked object or surface feature appears with a 
dotted polygonal outline rather than a solid outline.



Hide Object Tool
The Hide Object Tool, nested under the Lock Object Tool , functions in the Design Views and in the 
Surface Editor, and allows you to hide objects or surface features in the Design Views, the Walk View or 
both. The Hide Object Tool hides objects and surface features from the view, but does not actually 
remove them from the model.



Create 8-Sided Object Tool
The Create 8-Sided Object Tool draws an 8-sided polygonal object outline or surface feature. 



Create Irregular Object Tool
The Create Irregular Object Tool    draws an irregular-shaped polygonal outline, one segment at a time. 
This tool does not draw non-convex objects or surface features.



Create Rectangular Object Tool
The Create Rectangular Object Tool draws a rectangular polygonal outline. 



Connect Surfaces Tool
The Connect Surfaces Tool functions in the Design View and is used to connect two objects together at a 
common surface. A connection between surfaces is necessary to see any common surface features such 
as the colored, transparent or translucent surface features representing doorways or windows. Without 
the connection, surface features between objects will not be shared and holes will not penetrate both 
surfaces. 
A common misconception is that a connection will increase speed. This is not true. A connection should 
be made only where necessary, that is, where surface features are shared between two objects.



Add/Remove Handle Tool
The Add/Remove Handle Tool    functions in the Design View and the Surface Editor, and is used to add a 
new handle to an object or surface feature or to remove an existing handle. A handle represents a vertex-
the meeting of two object surfaces. 



Rotate Object Tool
The Rotate Object Tool    functions in the Design Views and the Surface Editor, and is used to rotate an 
object or surface feature. When rotating an object, this tool works in any view, thus allowing rotation on 
more than one axis.



The Lighting Editor Tool
The Lighting Editor Tool    functions in the Design Views and in the Tumble Editor and opens the Lighting 
Editor. The Lighting Editor lets you set the intensity and color of light sources inside a selected object or 
inside the Virtus world. 



Surface Editor Tool
The Surface Editor Tool    functions in the Design Views and Tumble Editor and accesses the Surface 
Editor.



The Tumble Editor Tool
The Tumble Editor Tool functions in the Design Views and accesses the Tumble Editor. The Tumble Editor
allows you to add a surface to a selected object by slicing off a piece of the object. The Tumble Editor 
also allows you to edit the color and opacity of a selected object or object surface. 



Color Bar
The Color Bar functions in the Design Views, the Surface Editor and the Tumble Editor, and displays the 
default color for new objects. It also allows new colors to be selected, created and assigned to objects or 
surface features. Colors can be applied to translucent as well as opaque objects and surfaces.
The current color displayed in the Color Bar is the default color for all newly created objects or surface 
features. The default color and the color of existing objects or surface features can be changed.



The Opacity Modifiers
Opacity Modifiers function in the Design Views, the Surface Editor and the Tumble Editor; these edit the 
opacity of entire objects, selected object surfaces or surface features. Object surfaces can be modified in 
the Tumble Editor or the Surface Editor, and surface features can be edited only in the Surface Editor.



The Inflation Modifiers
The Inflation Modifiers determine the inflation type, or shape, of an object. Inflation is the process of 
creating a 3-D object from a 2-D polygonal outline. The distance and the direction of object inflation are 
determined by the Depth Control Gauges.



Flat Shading Modifier
The Flat Shading Modifier    is the default Appearance Modifier when creating a new object. With this 
modifier selected, objects and object surfaces are displayed with shaded surfaces controlled by the 
default lighting and the polygonal outline of the object or surface. 
Library objects or other grouped objects must be ungrouped before they may be edited with the Flat 
Shading Modifier .

Changing an object to be flat shaded
Select the object to be shaded, and double-click the Flat Shading Modifier .



Smooth Shading Modifier
The Smooth Shading Modifier    is used when a more realistic image is required. With this modifier 
selected, objects and object surfaces are displayed with smooth gradations of color from surface to 
surface. Lighting still affects objects that are modified this way, but the effect is much less intense.
Objects without many facets do not usually benefit from being smooth shaded. The examples at left show 
some good and poor uses of the Smooth Shading Modifier .
Library objects or other grouped objects must be ungrouped before they may be edited with the Flat 
Shading Modifier .

Changing an object to be smooth shaded
Select the object to be shaded, and double-click the Flat Shading Modifier .



Layer List
The Layer List displays the names of the different layers that you create. When you are working on 
complex models, layers can be helpful. Individual layers may be locked, hidden or assigned a special 
color in the Design Views, or a layer can be hidden from the rendering in the Walk View. For example, if 
you were creating a building with many floors, you could put each floor in its own layer. You also might 
wish to put furniture in its own layer.
When you draw new objects, they are put in the layer whose name is highlighted in the layer list. Though 
it is possible to move objects to different layers, it is a good idea when drawing new objects to first 
highlight the layer where you want the new objects to reside. This will save you the time of having to 
move them later. Initially, there is only one layer, Unnamed, and all objects are put in this layer unless 
you create another.



Walk Mode Selector
The Walk Mode Selector, which enables navigation, is the default setting for the Walk View



The 3-D Object Selector
The 3-D Object Selector selects an object in the Walk View and centers that object in the 
Design View. When an object is difficult to locate in a complex model, the 3-D Object Selector is very 
helpful.



The 3-D Surface Selector
The 3-D Surface Selector allows the selection of an object's surface from the Walk View. This feature 
works just like the Design View's Surface Editor. A special feature of this tool allows for the surface 
selection of a grouped object (i.e. a chair or sofa as a library object).



Background Color Selector
The Color Bar at the top of the Tools Pad is the Background Color Selector used to change the color of 
the background within the Walk View. 

Changing the background color
Mouse down on the Background Color Selector (Color Bar) that is used to reveal the color selector. Drag 
the mouse to the desired color and release.



The Lens Focal Length Tool 
The lens size indicator and the sliding control beneath it are both parts of the Lens Focal Length Tool. If 
the sliding control is moved, the reading in the lens size indicator will change to display the new lens focal
length. You can also adjust the lens focal length by highlighting the numbers in the lens size indicator, 
then typing a new number and pressing the Enter/Return key. You must press the Enter/Return key for 
the change to take effect.



The Orientation Cube
The Orientation Cube shows the orientation of the Observer inside the Virtus world. If any objects can be 
seen, the Orientation Cube will indicate the side(s) of the objects that the Observer is facing: F=Front, 
B=Back, L=Left, R=Right, T=Top, b=bottom.
You can always tell your orientation in the model by noting the display of the Orientation Cube. It is 
especially helpful in orienting you when viewing a model that someone else has created.
The Orientation Cube also appears in the Tumble Editor, but has added functionality there.    



Record, Playback Path
As you navigate through a model in the Walk View, you can record and later play back the walk path with 
the Record Tool    and Playback Tool . 
The length of a recording is limited only by memory; however, it is unlikely that you will run out of memory 
because the requirement is small.
When you save a file, the recorded walk path is saved with it. When you open the file again, you can click 
the play button and view the recording. Only one recorded path can be saved with each model. If you 
record another, the previous path will be erased.



File Menu
Many of the WalkThrough Pro File menu options and commands are standard for the Windows operating 
system. These include New, Open, Close, Save, Save As, Print Setup, Print and Quit. If you are 
unfamiliar these options and commands, please review your Windows system documentation.

New 
New creates and opens a new WalkThrough Pro file.

Open... 
Open displays the standard Macintosh or Windows Open dialog from which you can select an existing
file to open. 

Close
Close closes the current file. If you made any changes to the file since the last time you saved it, you 
will be prompted to save the changes before the file is closed.

Save 
Save saves the current file under the currently used name.

Save As...
Save As... opens the standard Macintosh or Windows Save As. dialog that allows you to save the 
current file under a new name or in a different format. WalkThrough Pro gives you the option of saving
files as Virtus WalkThrough Pro (with textures embedded or linked) or Virtus VR.

Revert to Saved
Revert To Saved opens the last saved version of the current file. If you select this option, any changes
made to the model since the last time you saved it will be lost unless you first use Save As and save 
the changes to the file under another name.

Print
Print prints the active window centered on the page and enlarged within the constraints of the page. 
What you see is what will print. 

Print Setup
Print Setup opens the standard Windows dialog with which you choose printout size, paper 
orientation and other printing features.

Credits
Credits allows you to personalize your model by adding a custom splash screen to your file. After 
creating a    BMP image, select Credits. The standard system Find File dialog box will prompt you to 
locate a BMP to place. Also, there is a text area where you may describe your model (or location of 
the model) or give information about the artist. 

Import Trace Layer
Import Trace Layer allows you to select a 2-D file in BMP, 2-D DXF or TIFF format and import that file 
into a WalkThrough Pro model as a drawing template. Import Trace Layer allows you to import a line 
drawing, such as a floor plan, and draw objects over the line drawing, using it as a guide.

Export
Export allows you to save the currently open WalkThrough Pro file to another file format.
Export displays a pop-up menu containing the possible file formats to export to. Available file formats 
for exporting are DXF 2-D, DXF 3-D and Virtus Player.
Highlighting a file format displays a dialog containing options specific to the file format.



Snapshot
Snapshot allows you to save a view of a WalkThrough Pro model in another file format. The saved 
view can be a particular perspective in the Walk View, the drawing in a Design View, the Surface 
Editor window, the Tumble Editor window, the Lighting Editor window or a recorded walk path.
Snapshot displays a pop-up menu listing possible file formats to save the snapshot to. Possible 
formats are BMP, EPS, Illustrator and TIFF.

Make Movie
              This command allows you to save a recorded Walk Path as a movie file.

Taking a snapshot in Animator Pro or Video for Windows
You must first record a walk path using the Record Tool . If you have not recorded a walk path, the 
Animator Pro/Video for Windows format option will be grayed out and unselectable.

Library
Library allows you to create a new object library or open an existing object library. Choosing Library 
displays the standard Open dialog from which you can select an existing library to open. In addition to
the standard dialog buttons, the New button is displayed, which allows you to create a new library. 
Once a library is open, Library items can be added to or copied from the library.

Exit 
Exits WalkThrough Pro. If a model is open and changes were made since the last time it was saved, 
you will be prompted to save any changes before exiting.
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Edit Menu

Undo 
Undo undoes the last operation. This command is available in the Design Views as well as all Editors.

Cut 
Cut removes any selected objects, surface features or slices and places them in the Clipboard. Cut 
objects, surface features and slices can then be pasted with the Paste command.

Copy 
Copy copies any selected objects, surface features or slices to the clipboard. The difference between 
Copy and Cut is that Copy leaves the original in place, and Cut removes the original. Copied objects, 
surface features and slices can then be pasted with the Paste command.

Duplicate
Duplicate makes an exact copy of any selected object or surface feature and places it on or near the 
original. Duplicate does not copy to the Clipboard as does the Copy command.

Paste 
Paste pastes the contents of the Clipboard into the model. Clipboard contents can include objects, 
surface features or slices. Different rules apply for where these types of Clipboard content can be 
pasted. For example, you cannot paste a slice in the Design View because a slice has no meaning 
there. A slice can be pasted in the Tumble Editor. Similarly, surface features have meaning only in the 
Surface Editor, and object polygonal outlines have meaning only in the Design View.

Delete 
Delete removes (deletes) selected objects, surface features or slices without placing them into the 
Clipboard. Selected objects, surface features and slices can also be deleted by pressing the Delete 
key. The difference between Cut and Delete is that Delete removes objects completely, whereas Cut 
removes objects to the Clipboard so that they may be pasted again. 

Modify Selected
Modify Selected is a pull-out submenu of modifiers that may be applied to selected objects in the 
Design View and to selected surface features in the Surface Editor. If a particular option is not 
available, it will be grayed. If the Walk View is active, all options are gray.

Select All 
Select All selects all objects (displays all handles). If your entire model is being created as a library 
item, use the Select All command to select all the objects and then group them with Group under the 
Design menu.
All objects can also be selected by double-clicking the Select Object 
Tool .

UnSelect All 
UnSelect All unselects objects or surface features (removes handles). Another method of unselecting 
is clicking on the background in the Design View or Surface Editor.

Hide Selected 
Hide Selected hides selected objects and surface features. Hiding objects or surface features allows 
you to work with overlapping objects or surface features without having to shuffle them.

Show All
Show All displays all objects or surface features that have been hidden with either the Hide Object 
Tool or the Hide Selected command.



Lock Selected
Lock Selected locks selected objects in the Design View and selected surface features in the Surface 
Editor. Locking objects or surface features prevents them from being edited. When an object or 
surface feature is locked, its polygonal outline is dotted rather than solid.

UnLock All
Unlock All unlocks all objects or surface features locked with the Lock Object Tool    or with the Lock 
Selected command to allow editing.

Preferences
Preferences opens the Preferences dialog. The Preferences dialog allows you to set preferences for 
the appearance of the Design and Walk Views, navigation, measurement units and other application 
and model attributes. With the Preferences dialog, you can customize your application.
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View Menu
The View menu allows you to open new Design Views, change an open Design View to another view, 
make the Walk View active, access the Lighting Editor for the Virtus world, and manipulate the 
position of the Observer and the center of the active view.

Change View
Change View is a pull-out submenu that lists possible Design Views to which the current Design View 
window can be changed. Change View is only available when a Design View or the Surface Editor is 
active. If an option in the Change View submenu is not available, it will be grayed.
The Change View options are Top, Bottom, Front, Back, Left, Right and Opposite.

New View
New View is a submenu that lists possible views that can be opened in a new window. The new views
that you can open include the Design Views, the Walk View and the world lighting.

Set Home to Editor
Set Home to Editor specifies home as the center of the current Design View window. By using the 
home position as a reference point, you can quickly move the Observer or the center of the active 
Design View to the home position from anywhere in the Design View window. To move the Observer 
home, use the Home Observer command. To move the center of the Design View home, use the 
Home Editor command.

Set Home to Observer
Set Home to Observer specifies home as the position of the Observer. By using the home position as 
a reference point, you can quickly move the Observer or the center of the active Design View to the 
home position from anywhere in the active Design View window. To move the Observer home, use 
the Home Observer command. To move the center of the Design View home, use the Home Editor 
command.

Home Editor
Home Editor returns the center of the active Design View to the home position. Home is specified with
the Set Editor to Home command, the Set Observer to Home command or in the Preferences, 
Defaults dialog.

Home Observer
Home Observer returns the Observer to the home position. Home is specified with the Set Editor to 
Home command, the Set Observer to Home command or in the Preferences, Defaults dialog.

Center Observer
Center Observer moves the Observer to the center of the active Design View.

Reset Origin
Reset Origin resets the Origin to true 0,0 coordinates if it has been changed. 

Level Observer 
Level Observer orients the line of sight in the Walk View, making it level if it has been altered with the 
Shift key while navigating.
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Design Menu
The Design menu is available only when a Design View is active. If the Surface Editor, Tumble Editor, 
Lighting Editor or Walk View is active, the Design menu is replaced with the active window's 
associated menu.

Snap to Grid
Snap to Grid snaps objects, surface features and slices to an invisible grid when they are created, 
moved or edited. The grid is based on the ruler tick marks in the Design View, Surface Editor and 
Tumble Editor. Handles of objects, surface features and slices will "snap to" the grid when Snap to 
Grid is selected.
If you zoom in or out, the ruler tick marks change and, therefore, the invisible grid changes. For 
example, if each tick mark represents one inch, handles snap to the nearest inch. If each tick mark 
represents one foot, handles snap to the nearest foot.

Zoom In 
Zoom In increases the apparent scale and the apparent size of objects in the view by a factor of 2. 
With each Zoom In, the minor tick marks on the rulers represent a smaller unit of measurement. 
There is a limit to the range of the Zoom-In command. When you reach the limit, selecting Zoom In 
will have no affect.

Zoom Out 
Zoom Out reduces the apparent scale and the apparent size of objects in the view by half. With each 
Zoom Out, the minor tick marks on the rulers represent a larger unit of measurement. There is a limit 
to the range of the Zoom-Out command. When you reach the limit, selecting Zoom Out will have no 
effect.

New Layer
New Layer lets you add a new layer to the Layer List. If you select New Layer, a dialog appears with a
text box in which you can type the new layer name.

Delete Layer
Delete Layer deletes the selected layer in the Layer List. If you select Delete Layer you will be 
prompted to verify the deletion.

Group 
Group groups all selected objects treating them a single object. A grouped object can be moved, 
copied, rotated and scaled. It is important to group library items with the Group command before 
copying them to a library. 

UnGroup
UnGroup ungroups selected objects that were grouped with the Group command. Once you ungroup 
an object, all the objects that make up the group remain selected until you click somewhere else 
inside the view. This means that if you want to change the color of a grouped object, you can ungroup
it, select a new color and group the objects again. This only works if you want all objects within the 
group to be the same color.
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Light Menu
The Light menu is available only when the Lighting Editor is the active window. If the Design View, 
Surface Editor, Tumble Editor or Walk View is active, the Lights menu is replaced with the active 
window's associated menu. (See Lighting Editor.)

Apply Changes
Apply Changes causes the changes made within the Lighting Editor to be applied to the interior of the
selected object or to the world in your WalkThrough Pro model.

Revert
Revert changes the Lighting Editor back to the way it was when you last selected Apply Changes. If 
you made changes to the Lighting Editor, but you don't like the changes, you can basically "erase" 
them with Revert, as long as you have not applied the changes first.

New Light
New Light adds a new light to the Lights List. The new light can be directional or ambient and can 
have color.

Delete Light
Delete Light removes the selected light from the Lights List.
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Surface Menu
The Surface menu is available only when the Surface Editor is the active window. If the Design View, 
Tumble Editor, Lighting Editor or Walk View is active, the Surface menu is replaced with the active 
window's associated menu.

Snap to Grid
Snap to Grid snaps surface features to an invisible grid when they are created, moved or edited. The 
grid is based on the ruler tick marks. Handles of surface features will "snap to" the grid when Snap to 
Grid is selected.

Zoom In
Zoom In increases the apparent scale and the apparent size of objects and surface features in the 
view by a factor of 2. With each Zoom In, the minor tick marks on the rulers represent a smaller unit of
measurement. There is a limit to the range of the Zoom In command. When you reach the limit, 
selecting Zoom In will have no affect.

Zoom Out
Zoom Out reduces the apparent scale and the apparent size of objects and surface features in the 
view by half. With each Zoom Out, the minor tick marks on the rulers represent a larger unit of 
measurement. There is a limit to the range of the Zoom Out command. When you reach the limit, 
selecting Zoom Out will have no affect.

Move Forward
Used with multiple surface features that overlap, Move Forward shuffles the order of the overlapping 
features by moving a selected surface feature forward one position. For example, if the selected 
surface feature has three surface features in front of it, Move Forward will cause only two surface 
features to be moved in front of the selected feature. The third surface feature will move behind the 
selected feature.

Move to Front
Used with multiple surface features that overlap, Move to Front shuffles the order of the overlapping 
features by moving a selected surface feature to the front of all the overlapping features.

Move Back
Used with multiple surface features that overlap, Move Back shuffles the order of the overlapping 
features by moving a selected surface feature back one position. For example, if the selected surface 
feature has two surface features in front of it and two behind it, Move Back will cause three surface 
features to be moved in front of the selected feature and only one behind it.

Move to Back
Used with multiple surface features that overlap, Move to Back shuffles the order of the overlapping 
features by moving a selected surface feature to the back of all the overlapping features.
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Tumble Menu
The Tumble menu is available only when the Tumble Editor is active. If the Design View, Surface 
Editor, Lighting Editor or Walk View is active, the Tumble menu is replaced with the active window's 
associated menu.

Snap to Grid
Snap to Grid snaps slices to an invisible grid when slices are created, moved or edited. The grid is 
based on the ruler tick marks. Handles of slices will "snap to" the grid when Snap to Grid is selected.

Zoom In
Zoom In increases the apparent scale and the apparent size of objects and surface features in the 
view by a factor of 2. With each Zoom In, the minor tick marks on the rulers represent a smaller unit of
measurement. There is a limit to the range of the Zoom In command. When you reach the limit, 
selecting Zoom In will have no affect.

Zoom Out
Zoom Out reduces the apparent scale and the apparent size of objects and surface features in the 
view by half. With each Zoom Out, the minor tick marks on the rulers represent a larger unit of 
measurement. There is a limit to the range of the Zoom Out command. When you reach the limit, 
selecting Zoom Out will have no affect.

Reverse Slice
Reverse Slice changes which side of a slice is removed. The direction in which the slice is drawn 
through an object determines which side of the object is removed. If you drag from left to right or from 
top to bottom, the portion above or to the right of the line will be sliced off. If you drag from right to left 
or from bottom to top, the portion below or to the left of the line will be sliced off. Reverse Slice 
changes the slice direction.
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Walk Menu
The Walk menu is available only when the Walk View is active. If the Design View, Lighting Editor, 
Surface Editor or Tumble Editor is active, the Walk menu is replaced with the active window's 
associated menu.

Button Down
Button Down controls how movement in the Walk View starts and stops. If Button Down is selected (is
checked), movement begins when you press and hold down the mouse button. When you release the
mouse button, movement stops.
If Button Down is not selected, movement stops when you press and hold down the mouse button 
and begins when you release the mouse button.

Cross Hair
Cross Hair turns on and off the display of the cross hair in the center of the Walk View. The cross hair 
orients the mouse pointer when navigating through the model.

Velocity Grid
Velocity grid marks are the horizontal and vertical marks in the Walk View that display the points at 
which walk speed changes. Novice WalkThrough Pro users may find the velocity grid helpful while 
learning to navigate. The default for the velocity grid marks is off (not visible). 

Normal Speed
Normal displays all translucent and transparent object surfaces and surface features, and displays 
object color fill and wire frames.

Fast
Fast displays all translucent and transparent object surfaces and surface features and displays object 
color fill and wire frames, but does not display textures. 

Faster
Faster speeds up your walk through by not allowing you to see through transparent or translucent 
object surfaces or surface features.

Fastest
Fastest speeds up your walk through by displaying only wire frames of objects; no object color fill is 
displayed.

Record
Record allows you to record a walk path. You may also record a walk path by selecting the Record 
Tool    in the Tools Pad. Record allows access to the recording function when in Full Screen mode.

Play
Play allows you to play back a recorded walk path. You may also play back a walk path by selecting 
the Playback Tool    in the Tools Pad. Play allows access to the playback function when in Full Screen 
mode.

Stop
Stop stops a recorded walk path if one is playing. You may also stop a recorded walk path by 
selecting the Stop Tool in the Tools Pad.

Aspect Ratio
Aspect Ratio reads the aspect ratio setting in the Preferences, Navigation dialog and applies it to the 
Walk View.



Full Screen
Full Screen opens the Walk View window to fully cover your computer screen, including the Menu 
Bar. The Menu Bar is still there, but it is hidden. If you point to the normal position of the Menu Bar, 
you can still pull down the menus.
To change back to a normal screen mode, find the Walk menu by pointing to its normal position and 
select Full Screen again.
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Window Menu
The Window menu displays the names of all open windows, views and models, and contains 
commands for displaying the Tools Pad and the Depth window. The Window menu helps you quickly 
navigate through open views and models.

Tools Window
Tools Window displays or hides the Tools Pad. There is only one Tools Pad, though there are several 
sets of tools (see Windows). If the Tools Pad is hidden in one view or editor, it is hidden for all views 
and editors.

Depth Window 
Depth Window displays or hides the Depth window. The Depth window is a ruler, like the Design View
rulers, that contains a Depth Control. The Depth window displays the position and inflation distance 
for the active design view. If you change to another design view, the Depth window will change to 
display the position and inflation distance for the new view.

Coordinates Window
The Coordinates Window identifies the position of the mouse cursor in the active drawing area. The 
information in the Coordinates Window helps you measure and draw accurately. The Coordinates 
Window does not function in the Walk View. 

Textures Window
The Textures Window displays the Textures Window which allows access to applying textures to 
objects.
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Help Menu
The Help menu allows you to search an on-line text file for help with WalkThrough Pro. The Virtus 
WalkThrough Pro 2.0 Help System is meant as an on-line reference guide only. It does not contain 
any tutorial information. The Help System is intended as a supplement to the manual included with 
this software, NOT a replacement. Please refer to the manual for more detailed descriptions and 
guides about WalkThrough Pro.
The Help menu is a standard Windows menu. See your Windows documentation for more about the 
Help menu.

Contents
Contents displays an alphabetical listing of all topics available in the on-line help file. 

Search for Help On
Search for Help On allows you to enter a text string to search for specific information within the on-
line help file.

How to Use Help
How to Use Help displays information about the Windows Help menu system and instructions for its 
use.

About WalkThrough Pro
About WalkThrough Pro displays the version number and copyright notice for your WalkThrough Pro 
application.
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Virtus Galleries
Virtus Galleries are extremely useful because they provide many preconstructed 3-D objects 
and scenes that you can use in building your own models whether its an item or an entire 
room. Virtus Galleries are compatible for use with Virtus VR and Virtus WalkThrough Pro 2.0. 

To date, the Virtus gallery topics include:

Alphabet Rooms
      Explore and modify virtual rooms based on letters of the alphabet.
      - 26 scenes, including A is for Art, H is for House, M is for moon, etc.
      - virtual alphabet blocks.
      - 3-D galleries featuring numbers, and upper and lower case letters.
      - textures including more than 100 colorful enamels, paints, minerals and more.

Archaeology
      Explore and modify ancient ruins, temples, pyramids and more. 
      - 17 scenes, including the Temple of Neptune, Great Pyramid and Stonehenge. 
      - 3-D galleries featuring Roman and Viking weapons, temple parts, kitchen equipment and
more. 
      - 2-D galleries featuring many openings and entrances.
      - textures including stone, hieroglyphics, tiles and more.

Home Remodeling
      Remodel your living space to create your dream home. 
      - 5 scenes, including a beach cabin, mountain home and country club estate.
      - 27 models, featuring bathrooms, kitchens, living rooms, bedrooms, garages and more.
      - 2-D galleries with home doors and windows (opaque, translucent and transparent).
      - textures for indoors and

Interior Design
      Use the creations of famous designers to furnish your home or business. 
      - 12 scenes, including the Berlin House (Mies van der Rohe), Glass House (Philip Johnson) 
and Fallingwater (third floor, Frank Lloyd Wright).
      - 11 models of sample rooms and suites.
      - 2-D galleries with various styles of windows and doors.
      - textures including cabinet surfaces, ceiling panels, wallpaper, cloth and more.

Office Design
      Rearrange or redesign your work space. 
      - 5 scenes, including a general office, teleconference center and reception/conference 
room.
      - 3-D galleries featuring desks, office equipment (copiers, computers, etc.), office 
furnishings and modular conference and storage units.
      - 2-D galleries of doors and windows.
      - textures including wood, stone, leather, tile and more.

Science Fiction
      Build or modify fantasy worlds from far, far away. 
      - 5 scenes, including Dragonfly, Mirror World and Stellar Ark.
      - 45 models, including space stations, vehicles and astronauts.
      - 3-D galleries featuring spaceships, space vehicles, dissecting table and DNA dusters.
      - 2-D galleries of windows and doors.
      - textures including celestial bodies, lunar surface, starfields and more.



(Note: Virtus Galleries are modules and require that you have the applications Virtus VR or 
Virtus WalkThrough Pro 2.0 or later.)

To Order Virtus Galleries, call 1-800-847-8871 (1-800-VIRTUS1) 9:00am - 6:00pm EST

Virtus Alien Skin 

Virtus VR 

Back to Contents 
 




